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Abstract

This chapter provides a detailed understanding of editing and formatting operations in Microsoft Word, which are
essential for creating professional and well-structured documents. It begins by explaining the concept of editing,
including fundamental operations such as adding, deleting, copying, moving, and pasting text. These operations
form the basis of document modification and content management in word processing.

The chapter further explores various formatting techniques, including character formatting, paragraph formatting,
page formatting, and the use of bullets and numbering. It highlights the importance of formatting in enhancing
document readability and presentation. Advanced features such as borders and shading, headers and footers,
footnotes and endnotes, and page setup options are also discussed.

In addition, the chapter explains document previewing and printing processes, including print preview features, print
dialog options, and page range selection. These tools help users ensure accuracy and layout correctness before
producing a hard copy. Overall, this chapter equips users with practical skills required for efficient document editing,
formatting, and printing in Microsoft Word.
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Editing A Word Document:-

Editing a word file means making changes in the text contained in a file. Everyone needs to edit a word file at
some point or other to incorporate the changes which may arise. Editing a word file is one of the most basic MS
office word operations. Editing a file covers these basic areas.

e Adding new text.

e Deleting a part of the text
e Copying a text.

e Moving text.

e  Pasting text.

e  TFormatting text.

Thus, following are the simple operations for editing a word file.

1.For Adding New Text

If you want to add new text at the end of a file, simply place the cursor to the end part and start typing using the
keyboard.

For adding text in between a document, place the cursor to the required portion and start typing.

2.Deleting A Part of The File
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If you wish to delete some parts from the end of the file, take the cursor to the end point and keep pressing
“Backspace” till the text is cleared.

You can also select the part you want to clear by left clicking on the text and dragging the mouse along. After the
part has been selected, simply click “Backspace” and the text gets deleted.

3.Copying A Text

If you want to copy an entire word file, simply select the whole file or use keyboard shortcut Control + A and
then right click to select the option “Copy”. You can also use keyboard shortcut Control + C. Doing so will copy
the entire text.

If you want to copy selected text, you need to select the part of the text initially by left clicking and dragging the
mouse and then follow the same procedure.

4.Moving Text
e If you want to move some text from one part of the document to another, simply select the part.

e Right click upon the selected part and choose “Cut”.
e Move to the desired location where you want to move the cut part. Place the cursor at the desired place.
e (lick paste or use Control +V.
e The text block has moved from one part to another.
5.Pasting Text

Pasting a text is also simple as the copied contents simply need to be put in the desired place by right clicking and
using “Paste” option. Keyboard shortcut Control + V also does the same.

6.Formatting A Text
Formatting refers to changing the font style, size, italics and other related parameters. A good formatted text can
help in creating a nice impression. Further, formatting is required to highlight certain important factors and points.
The main steps to consider while formatting are as follows.

e Sclect the text that you want to format. If it is the entire document, click Control + A or select the
specific portion.

e After you have selected the part, you want to format, click on the Home tab in the top row.

¢  You can see a dropdown list with font name and adjacent to it you have another drop down list
displaying font size.
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As you can see, there are various fonts and you may select the one you want.
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As you can see in the above screenshot, you may alter font size with the drop box. You can change either of
them if you want another font or different size.
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You can adjust more with advanced font settings.

Just below the font name and size, you have another row with options like

Bold: if you want to bold some points, click on the icon. To remove bold, click again.
Italics: for italicizing a portion, click “I”. For removing the italics, click it again.

Undetline: if you wish to underline a part, click on the “U” button. Clicking on the same button again
will remove the underline.
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As you can see, the different options like Bold, Italics, and Underline are present in the home tab itself. There are
other options as well, like make a strikethrough, use subscript, change case from lowercase to uppercase or vice
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versa. You can even capitalize the first letter of each word or highlight a certain part using different colors.

Formatting document:-
(i) Character Formatting: before applying character formatting you have to select the text, after selecting the text
click on Font on Format menu and provide required settings such as:

(a) Under font tab: font, font style, size, font color, under-line.

(b) Under font tab: effects — emboss, shadow, superscript, subscript etc.

(c) Under character spacing tab: scale, positioning etc.

(d) Under text effect tab: las vegas light etc.

ii) Border and Shading: to apply border and shading, select the text and click on Border and Shading on Format
g PPy g g
menu.
(a) use Border tab: to apply border color, border type etc.
use Page Border tab: to apply border color, botrder type to the whole page.
g PPy typ pag
(c) use Shading tab: to apply fill color and pattern.

(iii) Paragraph Formatting: before apply paragraph formatting select the paragraph if formatting is to be applied on
multiple paragraph or, position insertion point on paragraph if formatting is to be applied on single paragraph then
click on Paragraph on Format menu and provide required settings such as:

a) Under Indent and Spacing tab: Set alignment of paragraph, specify paragraph alignment such as left, right,
center, justify and outline level

b)Under Indent and Spacing tab: Set paragraph indentation or margin such as left indent, right indent, under
special specify first line indent, hanging indent.

¢) Under Indent and Spacing tab: Set paragraph spacing such as paragraph before space, paragraph after space,
spacing between lines in paragraph.

(iv) Bullets and Numbering: Select the items you want to add bullets or numbering to. On the Formatting toolbar,
click Bullets or Numbering to apply bullets and numbering. To remove bullets and numbering from items select the
items, on the Formatting toolbar, click Bullets or Numbering.

(v) Page Formatting: formatting of page can be performed using following commands and their settings:

(a) Page Setup:

Under Margin tab specify, left, top, right, bottom margin, gutter margin(margin for binding the pages),
orientation of page (portrait or landscape). If you select mirror margin from Multiple pages, left and right margin
becomes inside and outside margin and gutter position is set to left, mirror margin and gutter margin are useful
when book is going to be prepared with bindings.

Under Paper tab specify paper size, paper source for first page and remaining page, height and width of custom
paper size.

Under Layout tab specify margin for header and footer text. page if you want to set different header and footer
text for first page, odd page and even page tick mark the option different odd and even, different for first. You can
set line numbers and border for page.

(b) Setting Header, Footer and Page no.: Header is the text that appears on top of page and footer is the text that
appears on bottom of the page. You can set title of chapter, author of the chapter or publisher, page no., date, time
or any thing that you want as header or footer text.

1. On the View menu, click Header and Footer to open the header or footer area on a page.

2. To create a header, enter text or graphics in the header area click on Insert Page No. icon on Header and

Footer toolbar .

3. To create a footer, click Switch Between Header and Footer icon on the Header and Footer toolbar to move

to the footer area, and then enter text or graphics.

4. If necessary, format text by using buttons on the Formatting toolbar.

5. When you finish, click Close on the Header and Footer toolbat.

Setting Footnote and Endnote:
Footnotes and endnotes are used in printed documents to explain, comment on, or provide references for text in
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a document. You might use footnotes for detailed comments and endnotes for citation of sources.

1. In print layout view, click where you want to insert the note reference mark.

2. On the Insert menu, point to Reference, and then click Footnote.

3. Click Footnotes or Endnotes. By default, Word places footnotes at the end of each page and endnotes at the
end of the document. You can change the placement of footnotes and endnotes by making a selection in the
Footnotes or Endnotes box.

4. In the Number format box, click the format you want.

5. Click Insert. Word inserts the note number and places the insertion point next to the note number.

6. Type the note text

Print preview:- Print preview is a feature that allows you to view what a printed version of the document would
look like on the screen before printing a hard copy. By using print preview, you can find any errors that may exist or
tix the layout before printing, which can save ink or toner and paper by not having to print more than once.

To open the print preview feature, click the print preview icon on the toolbar, like that shown in the picture or
click File and choose the Print Preview option.

& [& poF ¥

»

Print Previewl

Shortcut keys
Microsoft Word - Press Cttl + F2 to open the print preview for the document you're currently viewing.
Or Choose File =* Print Preview from the menu bar.
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Once you have accessed Print Preview, your document will now be in Print Preview mode. It will look
something like this:

Foundations of Computer Science and Information Technology, Edited By: Dr. Sunita Chaudhary 102


https://ibseries.com/index.php/IMBS/

International Multidisciplinary Book Series Vol. 1, Issue 1 (2023)
https://ibseries.com/index.php/IMBS/

| B B e Jemt Fomet Tk Tabe i |
| &0 @ < - %% O] k.
[l L S S

N =ED '
Pap L s TS mi @ FE FEEE EE] [
wlwat | 1 8 R || Mhaes soooary | Rsorn B[] 00en deare . FRN SRS BEE e

Print Preview mode displays how your file is formatted. If you want to take a closer look, use the zoom feature.
The zoom feature zooms in closer, giving you a better view of your file.

Following is the Print Preview toolbar:

EIECT a2

o *’ \

Multiple Pages V18w Ruler Close

e The Print button prints a file.
e The View Ruler button displays the vertical and horizontal rulers. Rulers help edit margin settings.

e If your file consists of multiple pages, the Multiple Pages button allows you to either view one page or
several pages at a time.

e Use zoom, then use the scroll bars to view your file.
e Use the Shrink to Fit button to fit your information to one page.
e If you want to exit or close Print Preview, click Close on the Print Preview toolbar.

Print :- To print the work following commands can be used :

1.Choose File =* Print from the menu bar (Cttl+P).
v The print dialog box will appear.
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Or Click the Print button =] on the Standard toolbar.
e file automatica rints. The print dialog box will not appear.
\/Th fil ically pti The print dialog b ill Pp

The Print dialog box:- Following image shows that how the Print dialog box looks like and has following
options in Word :

Printer selection

In the Name: drop-down box, the name(s) of your printer display(s). When working in an office environment, it
is possible that your computer is part of a network that accesses several printers. Make sure you direct your print job
to the correct printer.

Page range selection

The default setting is all. If you want to print only the current page, select the current page radio button. If you
want to print only part of a document but it is more than one page, select the Pages radio button and enter the page
numbers you want to print.

Copies selection

In this section, there is a Number of copies: box. The default setting is 1 copy. Manually enter the number you
want to print by highlighting the number. Enter the number of copies you want to print. You can use the up or
down arrows to indicate the desired number of copies.

Collate is the default setting. Collate means to put pages in the proper order. If you want to turn off the collating
feature, deselect the radio button. This means if you print more than one copy of a document, all of the first pages
will print together, all of the second pages will print together, and so on.

Print E
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//’ Mame: | S5 werox DT 220/230/332340 P52 x| Properties |
Printer-
Seaction Skatus: Idle
Type: Herox DC 220/230)332/340 P52
W'here: Eood2YERDKE ™ Print ko File
Carmment:
B —Fage range —i_opies
— o al Mumber of copies:
F'a‘n_:;e R?’”HE e Current page £ Selection
Selection
i~ Pages: I ¥ Collate
Enter page numbers andfor page ranges
separated by commas. Faor example, 1,3,5-12
Frint What
Section —Zoom
Frint what: ID::u:ument j Pages pet/shest ! |1 page j
Print: I.ﬁ.ll pages in range v| | Sealeta paper size: |M.:- Scaling v
S| / / T
! /
SP”}[?I Number
ection of Copies

Print what section
®  You want to print a document. Leave this at the default setting.
e Print section
e The default setting is all pages in range. However, in the drop-down box, select even pages or odd
pages if you want, or select a range of pages.
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